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CamRanger Hardware

The CamRanger device is turned on by sliding the power switch, located on the side of the unit,
towards the front of the device. The green power light will illuminate when the unit is powered
on. Any additional switch present on the CamRanger currently serves no function.

The charging port is located next to the power Wireless
switch. The male micro B end of the provided Power l—USB
white charging cord is connected to this port. The ' —|

other end of the charging cord can be connected
to a female USB port that provides power, such as Q\Fg":\
a computer or through the provided AC adapter. \Q<
When the device is charging, an additional yellow

light will illuminate next to the green power light

indicating that it is charging. The yellow light will
turn off leaving only the green power light when it

|—Power Switch

use Port Charging Connector

(connects to camera)

is fully charged.

The CamRanger battery is accessible by removing the bottom cover. The bottom cover is the
side with the CamRanger serial number. Simply grasp the side edge/corner of the cover near
the USB connector and pull back to remove. To replace the cover, first place the two lower tabs
into the slots and then snap in the top.

Hos4zasgy ., ,
’I‘a&"lﬂlﬂe’/ 2

A black neoprene case is provided to assist in attaching and securing the CamRanger, note that
this pouch is not waterproof. The case has a carabineer to facilitate hanging from a tripod, belt
loop, etc. Do not just hang the CamRanger by the cable as it will put strain on the USB
connectors as well as possibly disconnect.

Any switch on the opposite side of the power switch does not currently have any functionality.
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CamRanger Registration

Before a Mac can be used with a CamRanger, the application should be loaded on the Mac, at
no additional cost to the user, from the Mac application store or from the CamRanger website,
http://www.CamRanger.com/Downloads. Once downloaded, the CamRanger application needs
to be registered. Registration requires Internet connectivity. Before proceeding, confirm
Internet connectivity (do not connect to the CamRanger network).

Launch the CamRanger application and the following screen appears. If the registration pop-up
does not appear, from the “Help” tab on the Mac menu bar, click “Register,” and the following
screen will appear.

Please enter your serial code located on the back of your CamRanger:

CamRanger
Serial #: ABCDEFGH

Note: you must be connected to the Internet

Register

Enter the 8-character CamRanger serial number. The serial number is located both on the
bottom of the back cover as well as above the battery underneath the back cover. Note that the
serial number contains only letters and NO numbers.

Press the “Register” button to complete the registration process. A message box will appear
indicating registration was successful and the Mac can be used with the CamRanger. Exit the
application and then proceed with the setup process as detailed below in the CamRanger Setup
section.

If registration fails, confirm Internet connectivity and the CamRanger serial number before
contacting support@CamRanger.com for assistance.
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CamRanger Setup

Power on the CamRanger and confirm all four lights briefly appear. The CamRanger will take
approximately 30 seconds until it is fully initialized.

The first time the user connects to CamRanger from a Mac, the Mac needs to be registered. See
the CamRanger Registration section above.

Once registered, connect to the CamRanger network on the Mac. The network name will be
CamRanger-###, with the last three characters matching the last 3 characters of the
CamRanger’s serial number. Enter the network password, which is the full 8 characters of the
CamRanger’s serial number. The password MUST BE ENTERED IN ALL CAPS.

Connect the CamRanger to the camera with the provided black USB cable (Note: units
purchased through retailers will have a USB mini cable, which will work with most cameras. A
few select Nikons use a different cable, which may be purchased separately or the cable that
came with the camera will also work). The male A end is inserted into the USB port at the end
of the CamRanger, and the other end is connected to the USB port of the camera. Then ensure
the camera is turned on. When the camera is connected and turned on, the green light closest
to the edge of the CamRanger device will light.

Launch the CamRanger Mac application. The application will connect to the CamRanger and the
user will be able to control the camera. To attempt to manually initiate a connection, on the
Mac menu bar, click “Connection” and then “Connect.” Once connected, the following screen
will appear.

Connected to camera

For common problems with setup and connection refer to the Troubleshooting section of this
manual found on page 24.
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CamRanger Mac Application

Status Bar Recent Thumbnails
enon CamRanger x”
I MD Canon €05 7D | EFSOmm /1.4 USM
BUEN Focus  Timer HOR |
o N o > ¥ Y Advanced
e i T8 - x L Control
IMG, IMG_9156.)PG IMG_9157.)PG IMG_9158.)PG # Tabs
Main Image
View -
IMG_S159.PG  1/6
150400 8.0MP
Camera
Properties
Camera
Actions
Image Size
QWD Canon EOS 7D | EFSOmm f/1.4 USM Shots: 51

The status bar is located at the top of the application screen and provides the user with a
number of status elements.
From left to right:

e Camera Connection: Indicates if the CamRanger device is currently communicating with the
camera
e Connected: =/
« Disconnected: X
e Camera Battery Status: Indicates the approximate battery charge on the camera
e Camera Model Name
e Lens Model Name (Note: not all cameras or lenses are supported)
e Shots Remaining: Indicates the number of shots currently remaining on the camera’s
removable media using the current settings
¢ Quitting, maximizing, and minimizing a window
¢ Red, Yellow, and Green circle on upper left corner:
e Red: This serves no purpose and does not actually close the window. To close
the window, select “CamRanger” on the Mac CamRanger menu bar and then
“Quit CamRanger” or use the 38+Q shortcut.
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e Yellow: Used to minimize the window
e Green: Used to maximize the window
¢ Click on the extending arrows, located on the upper right corner of the screen, to
view the window in full screen. Remaining: Indicates the number of shots currently
remaining on the camera’s removable media using the current settings

Recent Thumbnails
..m;“'

¥ kg
| 2l O

IMG_5155.096 IMG_5156.P6 IMG_5157.0P6 IMG_5158.0P6 MG 5158076

e As images are captured, the thumbnails are automatically downloaded and displayed along
the top of the screen. The thumbnails may be scrolled left and right when more are
downloaded than can fit.

¢ A thumbnail may be selected to view the corresponding image. The image is downloaded and
displayed in the main image view. The currently selected thumbnail is indicated with a yellow
outline.

e When both a JPG and RAW file format is captured, only the JPG thumbnail is displayed.

e For Canon, JPG and RAW files can be viewed. For Nikon, JGP can be viewed while the RAW
thumbnail will display, but will not be shown at full resolution when selected. Instead all
Nikon RAW files will be displayed in a compressed JPG version. However, if the image is
saved, it will save the full NEF file. Viewing TIFF files is not supported.

e A small red “R” icon on the upper right of the thumbnail indicates that it is a RAW image. A
small green “T” indicates TIFF, while no icon is used to indicate JPG formatted images.

¢ Note: only thumbnails for images captured within the current CamRanger session will be
displayed.

Main Image View

Live view and captured images are displayed within the main image view.

Live View Images

To initiate live view, click on the eyeball symbol located within the camera action controls on the
bottom right of the application screen. In live view, the image on the screen is automatically
updated as live view images stream in. The exact frame per second rate is very much dependent
on the CamRanger WiFi signal strength, the camera, and the Mac specs. However, assuming a
good connection, the live view frame rate will be about 7 — 18 fps.

When in live view, the main image view may be clicked once to focus at that point. Note that for
Canon cameras, the outer edges of the image cannot be focused on. Double clicking will zoom
in the viewing window and double clicking again returns the image to regular size.

A live view histogram may be toggled on or off from the “Data” tab as described in the
Advanced Tab Data section found on page 9. Toggling the histogram on will generate a
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histogram for each live view frame; however, at the cost of a decreased frame rate. Toggle the
histogram off to maximize the frame rate.

Canon cameras can display the live view image on the camera and Mac and allow the user to
trigger images with the camera by activating the camera’s live view button after starting live
view within the CamRanger application. Nikon cameras do not allow any control of the physical
camera while live view is active within the CamRanger application.

Captured Images

Captured images will be displayed in the main image view in one of two ways, by selecting a
thumbnail in the thumbnails section of the application or through the Auto-View Images
feature. The Auto-View Image feature is useful when capturing images from the camera and
using the Mac application for image display. When this feature is selected, pictures will
automatically display in the main image view screen. This feature can be turned on or off by
selecting “CamRanger” on the Mac CamRanger menu bar and then “CamRanger Preferences.”
For more information about this feature, refer to the CamRanger Menu Bar Preferences section
of this document found on page 15.

When a thumbnail is selected for viewing, the image will be displayed on the main image view
and can be zoomed in at 50%, 100%, 200%, or fit to screen by selecting the magnification of
interest below the image. The image can then be panned using the mouse.

Images displayed in the main view are NOT saved by default, but are instead just temporarily
cached. Individual images can be saved by selecting “File” from the Mac CamRanger menu bar
and then “Save” or “Save As”. For further saving options including the ability to automatically
save all pictures, refer to the CamRanger Menu Bar Preferences section of this document found

on page 15.

To view the images on the camera’s memory card select “View” on the Mac CamRanger menu
bar and then “Card Contents.” A new window will appear displaying thumbnails of the images
on the camera’s removable media. Double clicking a thumbnail will display the image within the
main image view. Additional features for downloading or deleting images are also available. For
further information about the card contents, refer to the CamRanger Menu Bar Card Content
section found on page 17.
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Advanced Tabs

There are four tabs providing advanced information or controls: Data, Focus, Timer, and HDR.
An additional Tripod or StackShot tab is visible when the respective accessory is connected.

Data

The data tab shows an RGB histogram and meta-data associated with the image in the main
image view. The following meta-data is provided:

 2zief] Focus | Timer | HDR

e Shutter Speed

Aperture

MegaPixels (Note this is not file size, but image resolution)
¢ ISO

Metering Mode

Exposure Compensation Value

Within live view, the data tab will simply inform the user that live
view is on and provide a toggle switch to toggle the display of the
histogram. The histogram is updated in real-time, but at the cost IMG_9153.JPG 1/6 2.8
of slowing down the frame rate. IS0400  8.0MP

Focus

The focus tab is only enabled during live view and provides
advanced focusing controls. [ Data [NZSTEN Timer | HDR |

. Focus Adjust
Focus Adjust

There are two sets of buttons to move the lens’ focal plane
nearer or further from the camera. Each set has three buttons D n n ' a B
with different sized arrows to specify a large, medium, or small
step in focus. Tap the button to move the focus by a single
increment, holding down the button will have no affect.

Focus Nearer Focus Further

Focus Stacking

Step Size Number of Shots
[Medium |~ | 3 |~]
Focus Stacking
Focus stacking is a process of taking multiple captures with slight
changes in focus and then post processing them to enhance the 20l iz
depth of field. The automatic focus-stacking feature allows the
user to set the focus step size between in each shot and the number of shots to take. Each focus
step will move the focal plane further from the camera. So the user will want to set the focus to
the nearest plane desired to be in focus and start the stacking process from there. If too few
captures are taken, the process can be restarted from where the initial stacking ended. Note:
the post processing is not done within the CamRanger application.
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Timer [ Data_Focus [iis] HDR |

Time Lapse
The timer tab allows the use of the CamRanger as an Initial Delay [ : [
intervalometer as well as specifying exposure times when the R 8 -
camera is in bulb mode. Shot Delay [0 :
Time Lapse @ HDR - 3 Shots - Step Size 1/3
o The entry fields are used to specify the initial delay before the Bulb

first shot, the number of shots to take, and the delay in between
each shot.

o After configuring the settings, press the “Start” button to begin
the intervalometer process.

e The intervalometer commands are stored on the CamRanger
device, the Mac does not need to remain on or connected once the intervalometer command
is initiated.

e The “Shot Delay” should not be used for precision timing, particularly when the delay is only a
few seconds or less.

o If the user closes the CamRanger app after initiating the time lapse on the CamRanger, which
includes shot delays of 2 seconds or less, it may be difficult to restart the app since the
CamRanger is primarily communicating with the camera.

e Time Lapse — HDR

o If the camera is in manual exposure mode, a small HDR check box will appear allowing
the combination of a time lapse and HDR sequence.

« If the HDR check box is selected, for each time lapse capture, CamRanger will actually
take a sequence of bracketed images using the bracket parameters as specified within
the HDR tab.

e Time Lapse — Bulb

o If the camera is in bulb mode/shutter speed and the camera supports bulb shots, the
CamRanger has the ability to take Bulb shots during the time lapse. The bulb duration is
specified by the Shot Duration, located within the Bulb section, immediately below the
time lapse section.

o Before starting the time lapse sequence, a dialog will appear informing the user of the
time lapse parameters and provide an opportunity to cancel.

Bulb capture is only available

while the camera is in bulb mode.

Bulb

e The entry fields are used to specify the initial delay before the first shot and the length of the
exposure.

o After configuration, press the “Start” button to begin the bulb process.

e The bulb commands are stored on the CamRanger device and the Mac does not need to
remain on or connected.

10
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HDR

The “HDR”, or Advanced Bracketing, tab can be used to generate a series of photos with varying
exposures.

e Advanced Bracketing is only enabled when the camerais in Data__Focus _Timer
Manual mode.

e The Property field specifies the camera property to be SELR hutter Speed |~
varied. There are three options, Shutter Speed, Aperture, Initial Delay S
and ISO. (00 o0 130 |°]

e The Initial Delay field specifies the amount of delay, if any,
to take before beginning the bracketing sequence. Number of Shots Stops

e The initial value for the selected property is set with the 8 8
Start Value field.

e The total number of images to capture is specified by the

Number of Shots field.

e The possible Step Size values are up to 3 stops and specify
the how many stops to vary the exposure between each capture.

e The valid values for the Number of Shots are automatically determined based on the
values specified for Start Value and Step Size. For example a step size of 1/3 stops will
allow more shots than a step size of 3 stops.

e The starting point of the bracket is set within the settings and can begin at the shadows
(lowest exposure), mid-point, or highlights (highest exposure). If the starting point is set to
mid-point, the resulting sequence will start at the lowest exposure but with the initially
set value as the mid-point. See the Advanced Settings section for more information on
setting the HDR start point.

e After configuration, press the “Start” button to begin the bracketing process.

e HDR sequences may be done with Live View active for Canon, but not Nikon.

e Note: the post processing is not done within the CamRanger application.

Trip0d TClb Data Focus Timer HDR

When the CamRanger PT Hub and MP-360 (MP 101, Bescor, or
Hague) are in use with the CamRanger, an additional tab will
display for tripod control. The CamRanger Mac application
provides the user the option to pan and tilt the camera from
within the app at variable speeds. For more information refer to
the CamRanger PT Hub and Tripod section of this manual found

on page 21.

StackShot Tab

When the CamRanger PT Hub and StackShot are uses with the CamRanger, an additional tap will
display for controlling the StackShot. Refer to the separate CamRanger & StackShot Manual on
our website, www.CamRanger.com/help, for more information about using the CamRanger,

11
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CamRanger PT Hub, and StackShot. To use the StackShot with the CamRanger and CamRanger
PT Hub, the CamRanger firmware must be version 7 and up and the CamRanger software on the
Mac must be the most recent. These updates can be found on our website at
www.CamRanger.com/downloads.

Camera Properties
Auto Exposure Mode

Aperture '
ISO
Shutter 1/500 ISO 400 Capture
Speed P

Mode
White

Mode p Balance

aL + Focus
. 4 Mode

Image
Format

Exposure Compensation
& Bracketing

The above diagram indicates the camera properties, which are also listed below, that can be set
using the application:

* Auto Exposure Mode ® Shutter Seed

* Aperture * 1ISO

* Metering Mode * Capture Mode

* White Balance * Image Format

* Focus Mode * Exposure Compensation and Bracketing

Not all properties can be set for all cameras or in all modes. For example, the diagram above is
from a session with a Canon camera and for most Canon’s the auto exposure mode and focus
mode cannot be set. Disabled properties are indicated with a darker button background.

12
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Exposure Compensation & Bracketing

By clicking the bracketing button, the following controls will be displayed:

Clicking the arrows at the top right and left moves the exposure compensation. Holding down
the arrow will move the exposure compensation to its respective limit. The two buttons at the
middle control the bracketing amount. Clicking the arrows pointing in will reduce the bracketing
amount, while pressing the arrows point outward will increase the bracketing amount.

The bracketing is not set until the “Set” button is pressed. The “Close” button will dismiss the
dialog. Pressing “Close” without pressing “Set” will effectively cancel any adjustments made.

Camera Actions
Movie Mode

. . " M Auto / Manual
Live View :: m AF Focus Toggle
Image Capture

Capture

e The “Capture” button initiates the camera trigger. The exact camera behavior is dependent on
the camera and camera properties, most importantly the capture mode.

e For most capture modes, such as single, timer, or quiet the button performs the image
capture as expected. It should be noted that for some cameras, advanced modes such as
remote or timer the button will behave as single capture mode.

e Continuous capture mode differs between Nikon and Canon.

o Nikon: After selecting a continuous drive mode a dialog is displayed allowing the user to select
the number of images to capture. When the Capture button is pressed, that number of
images will be captured.

e Canon: When in a continuous mode, pressing and holding the Capture button behaves in the
same way as pushing the physical trigger on the camera.

e It is noted that there can be a very slight lag between the pressing of the “Capture” button
and the image capture. The delay can be more pronounced while live view is active. For time

13
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critical applications, a remote trigger, such as an RF trigger, can be used in combination with
the CamRanger.

Auto / Manual Focus Toggle

e The AF/MF Focus toggle button allows the user to change the focusing between auto and
manual without having to physically adjust the camera.

e This AF/MF adjustment is not possible for all cameras in all modes. For example, some Nikon cameras
are required to be connected in “PC” mode, which is accessible by selecting “Connection” on the
Mac CamRanger menu bar followed by clicking “PC.”

e After any touch or incremental focusing while in live view, the focus mode will automatically

attempt to switch to manual focus such that the user specified focus is not overridden by auto
focus upon capture.

Live View

e The “Live View” toggle button is used to turn live view on and off.

e When live view is on, the main image view is updated with live view images as well as
updating the RGB histogram in the Data tab if the live view histogram is turned on.

e Note: running live view is relatively intensive and there may be slight performance lags in
other areas.

Movie Mode

e The “Movie Mode” toggle button is used to turn live view on and off, but within movie mode.

e When movie mode is on, the main image view is updated with the live images.

e The “Capture” button changes to “Record” and pressing the “Record” button will start and
then stop the recording of a movie.

e Note: movies cannot be downloaded to the Mac using the CamRanger.

14
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Mac CamRanger Menu Bar

] ® CamRanger File Connection View Window Help

The CamRanger menu bar located at the top of the Mac display contains many useful functions
allowing the user to manage the connection, set options and controls, access to the camera’s

card contents, and to get help.

CamRanger Preferences

The preferences are accessible from the menu bar, by clicking “CamRanger” and then selecting

“CamRanger Preferences” on the dropdown.

Saving

e Saved Image Directory: As images are captured
they can be saved into a specified directory. If
pictures from the camera’s memory card are
downloaded to the Mac they will be stored in this
folder. Itis noted all images are stored on the
camera’s memory card.

e Custom Prefix: This will give the images taken
during the session a unique title preceding the
image number when saved to the card.

e Auto View Images: This feature provides three
different options.

e OFF: Images are not automatically displayed

e ON: Images are automatically displayed

e Camera: Images are not automatically displayed,
but can be displayed as dictated by the

photographer at the camera. To have an image be

displayed from the camera, it needs to be
modified on the camera. There are few ways this
can be done, but these methods may work well:
® Canon - Give the image a rating
* Nikon - Press the lock button to lock the
image
e Auto Save Images: When this feature is

selected, the images will automatically be

saved to the directory during the CamRanger

session regardless if the images are captured

from the Mac or the camera. This is typically

CamRanger Preferences

Saving
Saved Images Directory

/Users/Dave/Pictures Browse

Custom Prefix

Auto-View Images OFF " Auto-Save Images

Viewing
File Name Grid Lines Aspect Ratio 3:2 [V
Nikon RAW (NEF) Quick View
Image Overlay

/Users/Dave/Downloads/UPS/PinedaleCCM.png Browse

Controls
HDR Start Point
Mid-Point &g
Sharing
Enable Sharing

Show Clients

Auto Share Images  Auto Share Thumbnails £4 Share Live View

Watermark

Show Watermark

Watermark | My Photol Size Large g

used to use the CamRanger to “shoot into Lightroom” or other similar programs.

© CamRanger - Patent Pending
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Viewing

e Name: Displays the images file name at the bottom left of each image

e Grid Lines: Overlay a 3x3 grid over the main image view

e Aspect Ratio: Overlays red lines over the main image view to give the user visual feedback on
common cropping ratios. Note: this information is not saved with the image.

e Nikon RAW (NEF) Quick View: The NEF files will be viewed as a compressed JPG image

¢ Image Overlay: Browse to select a partially transparent image to be used as an overlay for
both live view and still images

Controls

HDR Start Value: Specifies where the selected HDR property value is within the bracket, at the
most exposed point (Highlights), least exposed point (Shadows) or in the middle (Mid-
Point).HDR Start Value: Specifies where the selected HDR property value is within the bracket,
at the most exposed point (Highlights), least exposed point (Shadows) or in the middle (Mid-
Point).

Sharing
Refer to the CamRanger Share section of this manual on page 20 for more information about
the sharing features.

Watermark

e Watermark: Insert text here to use for the watermark.

e Show Watermark: Displays a watermark over each full size image. When the watermark is
enabled and the user is sharing images to multiple devises, the watermark will be displayed
on the shared devices.

o Watermark Location: Specifies the location of the watermark: Center, Bottom-Right or
Bottom-Left.

File: Saving & Sharing Options

e The “Save and “Save as” options are beneficial for users who do not want all images captured
to be saved onto the Mac.
e Save: The image displayed on the main viewing screen can be saved to the default
directory by selecting “File” on the Mac CamRanger menu bar followed by “Save.”
e Save as: The image displayed on the main viewing screen can be saved to any directory
and any name by selecting “File” on the Mac CamRanger menu bar followed by “Save.”
e Images can also be auto-saved to the Mac computer via the CamRanger Preferences.
¢ Image Share: When sharing is enabled, the CamRanger user can chose to share individual
images being viewed in the main image view by selecting “Share” from the File drop down.

Connection
e CamRanger Connection: A state dependent “Connect” or “Disconnect” button is available to
the user as a troubleshooting option to avoid closing the application in the case of connection
problems.
e Nikon Connection Mode
e After selecting “Connection” on the menu bar, the options of “PC” and “Camera” are in
the dropdown.

16
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e PC: PC mode allows more control over properties within CamRanger; however, any
properties changed are not maintained, and changing settings on the physical camera
are not recognized. Additionally, images cannot be physically triggered from the
camera.

e Camera: Allows the camera to be physically used as normal; however, not all
properties will be enabled within CamRanger. The CamRanger application must be set
to Camera mode to allow physically triggering from the camera.

e It should also be noted that the connection mode cannot be changed while live view is active.

View

Card Contents

8 00 Camera Card Contents

. 'j “‘

2G6A9200.CR2 2G6A9198.CR2 2G6A9197.CR2 2G6A9196.CR2
2G6A9199.CR2

=

3,

2G6A9195.CR2 2G6A9194.CR2 2G6A9192.CR2 2G6A9191.CR2
2G6A9193.CR2

2G6A9190.CR2 2G6A9189.CR2 2G6A9188.CR2 2G6A9187.CR2 IMG_9186.CR2

=

To view the card contents select “View” on the Mac CamRanger menu bar and then “Card Contents.” By
doing this a new window will pop-up, as seen above. The card contents will display thumbnails of the
images on the camera’s removable media. The application will initially load the most recent thumbnails.
To load more thumbnails, press the “More” button at the bottom of the window. As seen in the picture
above, a small red “R” icon on the upper right of the thumbnail indicates that it is a RAW image. A small
green “T” indicates TIFF, while no icon is used to indicate JPG formatted images.

Any number of thumbnails can be selected by pressing a thumbnail, or all may be selected by pressing
“Select All” at the bottom of the window. Selected thumbnails will have a yellow border around them.
After selecting thumbnails they may either be deleted or saved. The “Delete” button at the lower left will
first prompt the user to confirm, and then delete the associated images of the selected thumbnails from
the camera’s removable media. The “Save” button at the lower right will save all associated images of
the selected thumbnails to the image directory specified in the preferences. Images are saved regardless
of format.

Images within the card contents view can be viewed by double clicking on the image. The image will
then appear in the main image view window.

Note that the thumbnails are presented in chronological order beginning with the most recent.

17
© CamRanger - Patent Pending



However, for Nikon they are grouped first by format, such that all JPG’s will be listed, then TIFF’s,
and finally RAW images.

Controls

When the “Control” function is turned on, the camera settings and image capturing can be controlled on
the Mac since the advanced controls tab, camera properties, and camera actions are accessible on the
right hand side of the application. Thumbnails of the images captured within the CamRanger session
will appear on the upper portion of the screen, the main image view will show live view or captured
images.

When the control function is turned off, the advanced controls tab, camera properties, and camera
actions will not appear on the application screen, while the thumbnails of images taken within the
CamRanger session will appear on the upper portion of the screen and the main image view will display
the captured images. The camera settings and image capturing can be controlled from the camera and
are not controlled on the Mac application.

Image Only

When “Image Only” is selected, the advanced controls tab, camera properties, and camera actions on
the right hand side of the application are not visible. The thumbnails of images taken within the
CamRanger session will not appear on the upper portion of the screen. When “Image Only” is not
selected, the advanced controls tab, camera properties, camera actions, and thumbnails are accessible
on the CamRanger application.

Window
The “Window” dropdown found on the Mac CamRanger menu bar allows the user to minimize and
zoom the screen, bring the CamRanger windows to front, and access the camera card contents.

Help
The “Help” dropdown found on the Mac CamRanger menu bar is useful for registering
CamRanger units and to access this help manual.

e Registration: By clicking “Register” the user can register a CamRanger. The user must be
connected to the Internet to complete the registration.
e CamRanger Help: Click “CamRanger Help” to view this document.

Incorporation with Lightroom or Capture One

While one cannot control the CamRanger from within Lightroom or Capture One, one can specify a
folder to automatically download images to. Refer to the CamRanger Menu Bar Preferences
section found on page 15 for more saving options. This folder can be set to as a “watch” folder
within Lightroom or Capture One and set to be automatically imported.
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Network Bridging

To set up network bridging the CamRanger must have firmware 6 and up and the CamRanger
Settings application must be downloaded on the Mac computer.

Refer to www.CamRanger.com/downloads for the CamRanger firmware update and for the
CamRanger Settings application and user manual to establish bridging on the Mac. For further
guidance, a YouTube CamRanger Settings application user video is available. Note that to bridge
networks it is recommended to be familiar with Internet networking.

Network bridging allows the user to be connected to the CamRanger and an additional Internet
network simultaneously. Previously when using the CamRanger, the Mac could only be
connected to the CamRanger WiFi network, making it so the user could not use any other
network when the CamRanger was in use. Once the bringing is established on the Mac, the
CamRanger can be connected to the Mac and successfully bridge between the CamRanger and
additional network.
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CamRanger Share App

In order for the CamRanger Share feature to work, the CamRanger firmware must be
updated to version 6 and up and the CamRanger software must be updated to the most

recent version. When the photographer is in a CamRanger session, others can view
images and live view on their personal iOS devices, Android devices, and/or Mac or
Windows computer. The CamRanger Share application is free and can be downloaded
from www.CamRanger.com/downloads. Individuals using the CamRanger Share app can only
view images and live view when the CamRanger is connected and the main CamRanger user has
enables sharing from within the settings.

The Mac Share settings, as seen below, can be accessed by selecting “CamRanger” from the
Mac menu bar followed by “Preferences.”

Sharing
( Enable Sharing [ Show Clients
| Auto Share Images | Auto Share Thumnails (¥ Share Live View

o Enable Sharing: When viewing an image in the main image view, individual images can be
shared by enabling sharing in the CamRanger Settings and then selecting “Share” from the
File drop down. One must Enable Sharing in order for the Auto Sharing, Auto Share
Thumbnails, and Share Live View settings to work.

o Auto Share Thumbnails: All images captured will display as thumbnails on the CamRanger
Share devices when Auto Share Thumbnails is enabled. The CamRanger Share user can scroll
through the pictures at his or her own pace.

e Auto Share Live View: The CamRanger share user will be able to see the camera’s live view on
their personal device when Share Live View is enabled. If an image thumbnail is not viewed
by the CamRanger user in the main image view, it will not be shared to the CamRanger Share
app users.

e Show Clients: The CamRanger user can see what devices are using the CamRanger Share
application during the CamRanger session.

Note that the watermark settings on the main CamRanger app will be set on all sharing devices.

Assuming that all devices have a good connection with the CamRanger, as the number of users
increase, the performance decreases slightly; adding 1 second per shared device for each small
JPG that is distributed is a good rule of thumb. Similarly, sharing live view with an additional 1
or 2 devices will not significantly degrade performance, but as more devices are added the
frame rate will reduce. Additionally, a device with a very poor/slow connection can degrade the
performance for everyone. The photographer using the CamRanger app can always temporarily
turn off sharing to kick off all shared devices. As the number of users increases the there are
practical performance limits. Depending on the scenario, practical maximums of 5-15 clients are
typical. The amount of data being shared as well as the network strength to all of the clients
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dictates the practical maximum.

If the CamRanger is only connected to the CamRanger network, the CamRanger Share app users
will also need to connect to the CamRanger network, using the same password, however no
registration is required. If the CamRanger is bridged to an existing Internet network, the Share
app user can connect to the same Internet network that the CamRanger is connected to, and
still use the Share app. Those using the share app should consult the CamRanger Controller
about the network connection and should stay within range of the CamRanger or bridged
network when using the app

For more information about the CamRanger Share Application, refer to the CamRanger Share
App User Guide Video (Note: this video is demonstrating the setup with an iPad, but the general
concept and use with the Mac is the same).

CamRanger PT Hub and Tripod

¢ To use the CamRanger PT Hub and Motorized tripod, a
CamRanger is required.

e The CamRanger PT Hub and MP-360 (MP 101, Bescor, or Hague)
will only work with CamRanger firmware 6 and up and the latest
Mac software. Refer to www.CamRanger.com/downloads for the
CamRanger firmware update and latest Mac application. The
CamRanger must be registered (see CamRanger user
manual) while the CamRanger PT Hub does not require
registration.

CamRanger PT Hub Hardware

e The CamRanger powers the CamRanger PT Hub.

Serial Connector port
(Cable included with
CamRanger PT Hub)

USB 2.0 A-end port (USB
2.0 A to B connector
included with CamRanger

Hub) USB port (USB cable

included with the
CamRanger or Camera)
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MP-360 Tripod Head Hardware

Camera Mounting Screw

Vertical Tilt
Head

Auto Pan Angle Selector Switch
Battery Compartment

Cover for 4 AA
Batteries

Power On LED
Main Power Switch

Pan Angle Indicator Socket for Serial Cable (included with CamRanger PT
Hub) or Hand Held Control Unit

e Install Batteries: Open the battery compartment by sliding the cover downward and lifting it
outward, insert the 4 AA batteries in the same position as the markings inside the battery
compartment.

e Mounting the Motorized Pan Head: The motorized Pan Head may be fastened to any tripod
or to any mounting device having a standard UNC %-20 thread mounting screw.

e Mounting the Camera: Fasten the camera securely to the top of the motorized tripod using
the mounting screw, which is a standard UNC %-20 thread. Align the optical axis of the
Camera with the long dimension of the Motorized Pan Head bodly.

¢ Specifications:

e Power source: 4 AA batteries or A/C adapter plug (neither included)

e Vertical Tilt Angle: +/- 15 degrees

e Horizontal Panning Angle: 360 degrees with unlimited rotation (If purchased through
CamRanger)

e Maximum Camera weight: 6 Ib (2.7 kg)

e Size (LxHxXxW):5.75x4.5 x4 inches (145 x 115 x 103 mm)

e Weight (without batteries: 1.75 |b (800 mg)

e Bubble Level: If desired, place the included adhesive bubble level on the top of the tripod (on
end with on/off switch).

CamRanger, CamRanger PT Hub, and Tripod Setup

e Required parts:
e CamRanger*
e CamRanger PT Hub
Motorized tripod (either the MP-360, Bescor, or Hague)*
USB cable (included with CamRanger or camera)
Serial Connector (included with the CamRanger PT Hub)
USB 2.0 A to B connector (included with CamRanger PT Hub)
e Camera*
e Device* (iPhone, iPad, Android device, Mac, or Windows computer)
*Requires charged battery or connection to AC power
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e Important tripod setup instructions:

e Set the Auto Pan Angle Selector Switch to 0° and the Main Power Switch to “M.” These
settings are required for 360° rotation and control from within the CamRanger app. The
45°,90°, and 340° auto pan settings on the tripod head serve no function.

e Level the tripod if necessary for your application.

e When securing the CamRanger and CamRanger PT Hub to the camera setup, do not
mount to the tripod. Mount the CamRanger and CamRanger PT Hub to the motorized
tripod or camera strap and make sure the units can rotate freely around the tripod.

Motorized Tripod Head

CamRanger

i
' § Camera
USB Cable
(Included with CamRanger

(B end) or Camera) \

USB 2.0 Cable (Included
with CamRanger Hub)

Serial Connector Cable
(Included with CamRanger

PT Hub) \

Diagram of setup for the CamRanger, CamRanger PT Hub, motorized tripod, and camera.

(A end)

23
© CamRanger - Patent Pending



Tips & Troubleshooting

Below are some tips and troubleshooting for common questions or issues arranged by category:

Registration

e If the CamRanger Mac application is re-installed, the Mac may need to be re-registered.

e Most registration issues are due to not having Internet connectivity or entering the serial
number incorrectly.

e If you still have issues, please email support@CamRanger.com for assistance.

Connection

e Make sure CamRanger is fully powered on and initialized (it should take approximately 30
seconds). The power light and WiFi light should both be on.

e The password to connect to the CamRanger WiFi is the CamRanger serial number in all CAPS.
If there are still issues connecting, turning the Mac’s WiFi off and then back on may help.

e If the CamRanger application is connected to the CamRanger device, but no camera is
connected, it will attempt to connect to a camera approximately every 5 seconds.

e If the Mac is outside of or near the edge of the range of the CamRanger unit there will be
connection problems.

e Disconnect and reconnect the CamRanger by selecting “Connection” then Connect on the
Menu Bar to force a new session/connection.

e Power cycling the camera and CamRanger as well as restarting the application will completely
refresh the connection.

e When the camera battery begins to get low, certain commands may start to fail or a
connection may be refused.

e The CamRanger hardware can only be connected to a single Mac at a time.

¢ A second network connection, such as with an Ethernet cable, can cause connection failures.

e If there is an inconsistent or intermittent connection, the issue is likely related to the USB
connection and different USB cable will often fix the problem.

e If the camera has in-camera WiFi capabilities, it must be turned OFF to make a connection
with the camera.

Speed

e The CamRanger has all the same distance and interference limitations as normal WiFi. Long
distances and solid objects will slow the connection speed.

e The CamRanger application can handle very large image files. However, waiting for those files
to transfer from the camera and then over WiFi can be time consuming. A common operating
mode is to shoot RAW along with a small or medium sized JPG.

e Newer and faster Mac computers do perform better overall, particularly for intensive tasks
such as showing the 100% resolution images.

Commands

e Depending on the camera and the mode, capture can fail if the camera fails to acquire focus.
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e Intervalometer and Bulb commands are stored on the CamRanger hardware such that the
Mac does not need to remain on and connected.

e When an operation, command, or setting is not available or not working the issue is often
related to the camera setup. For example:

e Toggling to AF is disabled if the camera lens switch is set to MF.

e Live view will fail on Canon cameras if Live View Shooting is disabled in the camera’s
menu.

e Capture fails because the removable media on the camera is full.

e For Canon cameras, the Live View focus mode within the camera’s menu must be set to “Live
View”.

e Adjusting or viewing the number of bracketing shots is not currently supported. The display
assumes three shots. However, if the number of shots is actually 2, 5, 7, 9, etc. the bracket
amount is still correct it will just incorrectly display 3 shots.

e Some features are not supported by some cameras. For example continuous capture mode is
not supported on the Canon 40D and many Nikons do not support bulb shots. See the camera
capability matrix at www.CamRanger.com/supported-cameras/ for more detailed information.

e If touch focusing does not work on a Canon camera, the likely cause is that the rear AF button
has been changed to some other function and must be reset back to its default AF behavior.

Images

e The thumbnails are not downloaded until after the image has been recorded to the camera’s
card. On most cameras this is relatively quick. However, depending on the camera, speed of
removable media and number of shots taken in succession, there can be a lag.

e CamRanger can be used to view and download pictures captured through other means. So a
photographer could be capturing images, or a RF or light trigger could capture images and the
CamRanger application would automatically download the thumbnails.

e If shooting to multiple cards, ensure the playback card is set to the memory card of interest.
So if shooting RAW to card one and JPG to card two and viewing the JPGs is desired, then set
the playback card to card number two.

CamRanger PT Hub and Tripod

* If the tripod head becomes unresponsive, securely reconnect the serial connector to the
tripod head.

* The speed of the tripod may vary depending on the weight of the camera and battery life
of the tripod head.

®* When using the CamRanger PT Hub, the CamRanger battery will drain more quickly.

For any and all questions related to your CamRanger, please email
support@CamRanger.com for prompt responses.
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